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GrafNav/GrafNet Version History 

 

What’s new in Version 9.00.2207? 

Available: February 2024 
 
Processing 

• Support for BeiDou B2b has been added to all processing engines 

• PPP-AR engine has been upgraded for full-frequency support, allowing for convergence in as fast as 3 
minutes 

• Introduced new option that can reduce multi-base differential processing times by up to 90% by limiting the 
number of baselines used concurrently in the filter. The option is available under the Measurement tab of 
the Differential GNSS Settings. 

• Memory usage when processing with ARTK has been reduced by up to 85% 

• Fixed issues with pre-processing for use-cases where base stations did not fully overlap with the remote 
 
Utilities 

• New option for HxGN SmartNet subscribers that allows them to reduce their quota consumption by 
requesting RINEX data at a lower rate and allowing the software to handle the interpolation. The option is 
available under the Services tab of the Preferences dialog. 

• Support for single-parallel Lambert Conformal projections has been added 
 
Decoders 

• Added support for the following RINEX 4.00 navigation message types: LNAV (GPS & QZSS), FDMA 
(GLONASS), D1/D2 (BeiDou), INAV/FNAV (Galileo) 

 

What’s new in Version 9.00? 

Available: August 2023 
 
GUI 

• New streamlined user interface makes Waypoint software more intuitive and easier to navigate 

• New icons and branding for the Waypoint software suite 
 
Processing 

• Support for BeiDou BDS-3 signals (B1C & B2a) has been added to all processing engines 
 
Utilities 

• The Download Service Data utility now supports the FTPS protocol, which restores access to the CDDIS 
service 

Waypoint Software Products 
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• Added support for cases where the same RINEX base station files are being downloaded simultaneously 
by multiple instances of the software 

• Resolved issue where the software update tool would occasionally fail to detect or download new versions 
of the software 

 
Decoders 

• Added capability for decoding BeiDou BDS-3 signals to the NovAtel OEM/SPAN, Leica MDB and RINEX 
decoders 

 
Security 

• Software installation files are now digitally signed to assure users of their authenticity 

• Several key security improvements that further enhance software robustness 
 
Command Line Interface (CLI) 

• Users can now export KMZ files 
 

What’s new in Version 8.90.8520? 

Available: May 2023 
 
Processing 

• Resolved issue with PPP processing of recently collected datasets 

What’s new in Version 8.90.8304? 

Available: May 2023 
 
Processing 

• Added support for TerraStar-NRT precise files referenced to ITRF2020 

• Added support for precise orbit files (SP3) referenced to ITRF2020 

• Added support for Version 3.04 of the precise clock (CLK) file format 

• Fixed issue where geostationary BeiDou satellites were being mishandled 
 
Decoders 

• Fixed issue with Javad decoder affecting ephemerides for Galileo satellites with a PRN above 30 
 
Utilities 

• Fixed issue where Download Service Data utility would falsely report an error when downloading same-
day TerraStar-NRT data 

What’s new in Version 8.90.6611? 

Available: June 2022 
 
Utilities 
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• Waypoint software now connects to NovAtel’s file servers using SFTP protocol instead of FTP protocol.  
This impacts downloading manufacturer files, TerraStar-NRT files, and software updates.  The existing 
FTP servers will be decommissioned later this year.  Click here for more details. 

 
Processing 

• Fixed issue where BeiDou satellites greater than 37 could not be omitted 

• Fixed issue where antennas with very large entries in the ATX file would not be loaded 
 
Decoders 

• Fixed issue where RINEX decoder could crash on datasets with a very large number of satellites and/or 
measurements 

• Fixed issue with RTCMV3 decoder when handling MSM messages that contained unrecognized signals 

What’s new in Version 8.90.5126? 

Available: December 2021 
 
Processing 

• Made adjustments to PPP-AR engine in preparation of the upcoming changes to the TerraStar-NRT 
service 

• Made general improvements to PPP-AR performance 
 
Download Utility 

• Fixed issue where RINEX decoder would fail to load if current directory was too long 

• Added support for use-case where the same TerraStar-NRT files are being downloaded simultaneously by 
multiple instances of the software 

• Fixed issue where HTTPS connection to public servers could fail depending on user’s firewall 
configuration 

• Fixed issue where utility did not always download enough base station data to fully overlap the requested 
time range 

 
Command Line 

• Fixed issue where -procint command would fail under certain use-cases 

What’s new in Version 8.90.4806? 

Available: August 2021 
 
Download Utility 

• Added support for connecting to HTTP and HTTPS servers 

What’s new in Version 8.90.4416? 

Available: April 2021 
 
NovAtel’s Waypoint post-processing software now includes built-in support for HxGN SmartNet, the world’s largest 
GNSS reference station network.  Users with a valid HxGN SmartNet subscription can enter their login credentials 

https://novatel.com/support/bulletins-alerts-release-notices/waypoint-migration-from-ftp-to-sftp-server
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through the Preferences menu. By doing so, the Download Service Data utility will seamlessly integrate the service 
and its stations into its search routines to facilitate the download of nearby RINEX data. 
 
Processing 

• Improved GLONASS fixed integer performance with ARTK for users working with Leica receivers 
 
 
Decoders 

• Improved station-decoding support in Leica MDB decoder and expanded the list of recognized models 

• Improved L2C support for Septentrio receivers 

• Added support for the [SX] message (Extended Satellite Indices) to the Javad decoder 
 
Command Line 

• Improved support for users automating differential processing of short surveys when PPP is required to 
determine base station coordinates 

 
Download Utility 

• HxGN SmartNet base station network is now supported (subscription required) 

• Fixed an issue affecting successful download of RINEX V3 stations 

• Added multiple RINEX V3 sources from existing services, providing the option to download multi-
constellation base station data. 

• Added GNSS stations from the Texas Department of Transportation (TxDOT).  This service includes 222 
new stations, 153 of which are already supported on other networks and 69 new stations. 

 
GUI 

• Addressed a licensing conflict that caused slow start-up times for users who previously had Version 8.70 
or older installed on their machine 

 
Licensing 

• Users requiring offline activation can now complete the process through the Local License Manager 
interface instead of using the command-line 

What’s new in Version 8.90.2428? 

Available: April 2020 
 
Processing 

• Improved PPP-AR performance 
• Fixed an issue impacting Galileo-only processing 

 
GUI 

• Users can now specify their Activation ID(s) for automatic license activation (upon opening the software) 
and return (upon closing the software).  This helps to avoid lost licenses among groups of users who are 
sharing Activation IDs by ensuring the license is returned when not in use.  It also helps minimize the 
possibility of losing a license in the event of a hard drive failure. 

• Export Wizard now includes a profile for GPS Exchange Format (GPX) 
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Decoders 

• Added support for MSM4 and MSM6 messages to RTCM decoder 

• Septentrio decoder now supports message block #5902 (ReceiverSetup) for easy extraction of antenna 
information (to STA file) and product name (to GPB file) 

• Javad decoder now supports GPS L5 and GLONASS L3 observations, as well as Galileo ephemerides 
 
Command Line 

• WPGCMD now supports base station resampling via new -procint command.  See help file for details. 
 

Manufacturer Files 

• Added Favourites groups to store published positions of Ordnance Survey (OS), EPN, TrigNet, UNAVCO, 
and IGN (ITRF2014) services 

• Added RENEP (Portugal) and SONEL (global) RINEX services to the Download Utility 

What’s new in Version 8.90? 
Available: January 2020 
 
Processing 

• Users working with NovAtel receivers and subscribed to the TerraStar-NRT service can now process their 
data using the new PPP-AR engine, which is based on the same technology that powers NovAtel’s 
TerraStar-C PRO service.  The new functionality works in both the forward and reverse directions. 

 
Bug Fixes 

• Fixed issue where OEM4 decoder would sometimes falsely report 0% idle time warnings 

• Fixed issue where RINEX decoder would fail to decode observations if no navigation file was available 
 
Note  

• Version 8.90 will be the final version that offers a 32-bit variant (available upon request).  All subsequent 
releases will only be available as 64-bit versions. 

What’s new in Version 8.80.2720? 
Available: July 2019 
 
Processing Engines 

• Third frequency band (includes GPS L5/BeiDou B3/Galileo  E5a/QZSS L5) can now be used as 
replacement for GPS L2/BeiDou B2/Galileo E5b/QZSS L2C during PPP processing 

 
GUI/Tools 

• The ability to apply a 3D offset when exporting features for GNSS-only trajectories has been brought back 
to the Export Wizard 

• Fixed a localization issue with the Local License Manager that would cause a crash for certain users 
depending on their Region settings in Windows 

• The Plot Raw GNSS Data feature now allows for C/N0 plotting of GPS L5/BeiDou B3/Galileo  E5a/QZSS 
L5 measurements 



GrafNav/GrafNet Version History 

21 February 2024 6 

What’s new in Version 8.80.2503? 
Available: May 2019 
 
Bug Fixes 

• Fixed issue where plotting tool would not remember the HMS/SOW display preference 

• Fixed issue where European TerraStar-NRT server would fail to connect 

• Fixed issue where Add Precise Files would display an error message when downloading less than 24 
hours of data over a day cross-over 

• Fixed issue in Profile Manager where constellations were not always available for selection 
 
Decoders 

• NovAtel OEM/SPAN decoder now supports GALINAVEPHEMERISB and GALFNAVEPHEMERISB 
records 

What’s new in Version 8.80? 
Available: March 2019 
 
Processing 

• ARTK has been updated to OM7Mx0400RN to ensure users benefit from all improvements implemented 
in the real time RTK engine  

• Third frequency band (includes GPS L5/BeiDou B3/Galileo  E5a/QZSS L5) can now be used as 
replacement for GPS L2/BeiDou B2/Galileo E5b/QZSS L2C during differential processing 

• 64-bit architecture allows for faster processing times 

• Number of satellites supported for differential processing has been raised to 40 

• When setting base station positions using the “Compute from PPP” button, some quality metrics are now 
displayed 

 
GUI/Tools 

• Local License Manager now stores 5 most recent Activation IDs for easy recall 

• When setting base station positions using Favourites, the user can now specify the epoch they want to 
move the coordinates to 

• Sky Plot now handles up to 100 satellites 
 
Decoders 

• Added support for the RANGECMP_1B measurement log to the NovAtel SPAN/OEM converter 

• Added support for PDPPOS and PPPPOS position logs to NovAtel SPAN/OEM converter 

• Added support for Galileo E6 and GLONASS L3 decoding to the NovAtel SPAN/OEM and RINEX 
converters 

• Added support for u-blox F9P receivers 

• Added support for BeiDou and Galileo ephemerides to Septentrio converter 

What’s new in Version 8.70.8722? 
Available: July 2019 
 
Decoders 

• Fixed issue in Javad/Topcon decoder where GLONASS ephemerides were not being decoded 
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• Fixed issue in RINEX decoder where GNSS constellation identifiers which were left blank were not being 
properly treated as being GPS 

What’s new in Version 8.70.6912 
Available: September 2018 
 
NovAtel’s Waypoint post-processing software is now available with access to TerraStar Near Real-Time 
(TerraStar-NRT) precise satellite clock and orbit products.  These multi-constellation products have an 
approximate 15-minute latency, which facilitates Precise Point Positioning (PPP) in applications that require a 
quick turnaround.   
 
A free 7-day demo of the Waypoint with TerraStar feature may be requested through our website here: 
https://www.novatel.com/products/software/ 
 
Processing 

• Waypoint with TerraStar feature is supported (separate activation ID required) 
 
SDK 

• Fixed an issue computing distances to reference stations within Downloading class 

• Fixed an issue reading antenna height in the GetPrecisePosition() function 
 

Decoders 

• Added support for the RTCMV3REFINFO command in the NovAtel decoder.  This allows users to ensure 
their antenna profile is selected automatically when importing data. 

 
Export Wizard 

• Fixed an issue that would result in a crash when exporting very large surveys 

• Increased the maximum number of features that can be exported to 1,000,000 and added checks to 
ensure sufficient memory is available 

• Removed a restriction in the Export Wizard where points with elevation values >50 km would not be 
exported (required to support space applications) 

 
License Management 

• An “Activator Info” string may now be entered in the local license manager when activating a license.  This 
string may be queried through the customer FlexNet portal to determine who has the license activated. 

What’s new in Version 8.70.6404? 
Available: April 2018 
 
Documentation 

• Added a link to the new Waypoint user documentation support portal under the Help menu 
 
Processing 

• Added support for Galileo within the PPP and PPP TC processor 

• Changed the supported secondary frequency for Galileo to E5a from E5b 

• Improved dual frequency Galileo fixed integer performance (ARTK) 

https://www.novatel.com/products/software/
https://docs.novatel.com/Waypoint/Content/Home.htm
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• Optimized satellite-selection criteria in differential processing to ensure best results when GPS, 
GLONASS, BeiDou, Galileo and QZSS satellites are tracked at the remote and base station receiver(s). 

 
Decoders 

• Leica System 1200 decoder has been expanded to support BeiDou, Galileo and QZSS 
 
SDK 

• Fixed an issue with the IsConstellation() method within ObservObj which is used to determine what 
constellations are present in a GPB file 

What’s new in Version 8.70.5101? 
Available: November 2017 
 
Decoders 

• Added support for RANGECMP4 logs to NovAtel decoder 

• Added Galileo support for RINEX v2.11 observation files 
 

SDK 

• Fixed an issue where the exported file would always show the datum as being WGS84 

• Fixed an issue where velocities were being incorrectly applied when loading from Favourites 

What’s new in Version 8.70.4517? 
Available: May 2017 
 
Decoders 

• Updated NovAtel decoder to output real-time solution into new trajectory format for easy loading within 
projects 

• Added MSM5 and MSM7 message support to the RCTMV3 decoder, in addition to BDS, QZSS, and 
Galileo ephemeris support 

What’s new in Version 8.70.4301? 
Available: March 2017 
 
Processing 

• Improved integer fixing performance affecting multi-base surveys where all base stations are not tracking 
the same constellations.  This can result in significantly more fixed integer solutions in large multi-base 
surveys. 

• Fixed an issue where multiple satellite/baselines omissions could not be entered through the ard GNSS 
settings 
 

Moving Baseline Support  

• Added functionality to output an HMR file computed from moving baseline data (Output | Export to 
Waypoint HMR format).  HMR files can be input to Inertial Explorer as a source of heading updates.  This 
feature could be useful for Inertial Explorer customers who log raw GNSS data from two or more receivers 
on the same vehicle. 
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Export Wizard 

• Fixed an issue affecting export of any variables dependent on the ECEF vector 

• Fixed an issue that would result in occasional invalid output of ECEF coordinates, grid coordinates and 
other variables 

 
GUI 

• Fixed an issue where the base station datum was not saved when using the “Compute from PPP” feature 
on the master coordinate dialogue and applying a processing datum other than WGS84 

What’s new in Version 8.70? 
Available: November 2016 
 
Processing 

• GLONASS integer ambiguity resolution will be automatically attempted when processing in differential 
mode.  This generally results in more fixed integer solutions in mixed GNSS signal conditions, more 
accurate fixed solutions and lower probability of incorrectly fixed solutions. 

• Galileo and QZSS are supported within the differential processor (float and fixed solutions) 

• GrafNav projects now accept up to 32 base stations (formerly the limit was 8).  This enables users to 
process large project areas with dense base station coverage more efficiently.  The filter will still only 
accept raw measurement data from the nearest eight. 

• Faster loading & scanning of 8.70 converted GPB files.  This significantly reduces the time required to 
process large multi-base projects. 

• ARTK has been upgraded to OEM060700RN to ensure GrafNav users benefit from all improvements 
implemented in real time RTK engine 

• Increased the baseline distance over which ARTK will rewind integer ambiguities 

• Fixed an issue that would affect ARTK performance if the base station sampling rate was lower than the 
remote sampling rate 

• Users can now specify their processing datum independently of their base station coordinate datum.  If the 
base station coordinates have been entered in a different datum than the processing datum they will be 
automatically converted prior to processing. 

• Improved outlier detection performance at project startup and immediately following a Kalman filter reset 

• Added time correlation handling within static differential GNSS processor.  This ensures estimated errors 
do not become problematically optimistic and do not vary significantly with the processing interval. 

• Removed support for “PPP_ETCOFF” command which could be used to disable Earth tide corrections 

• Fixed an issue loading IONEX files (Map of the TEC) relevant to single frequency processing  
 
Licensing 

• USB licensing is no longer supported.  Users must have a software-based license to use version 8.70. 

• A single remote desktop connection is now supported within the permanent license model, potentially 
reducing the need to transfer the software-based license between computers. 

• More efficient licensing checks have been implemented during processing, resulting in processing speed 
improvements. 
 

Output file formats 

• GrafNav now writes to a new binary trajectory format which was necessary to best support future 
improvements.  Version 8.70 maintains backward compatibility with old solution files.  When opening an 
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8.60 or previous project in 8.70, a previous solution can be loaded through File | Load, and it will be 
automatically converted to the new format.   
 
Version 8.70 also includes a “Export Waypoint Legacy Format” option under the Output menu which will 
produce the former ASCII trajectory format for any users who require these in their downstream workflow. 

  
GUI 

• Users can now specify a default GNSS processing profile within the “Solution” tab of Settings | 
Preferences.  This enables more efficient workflow for customers who use their own customized profiles, 
or who have noticed errors in the automated processing environment/profile detection. 

• When loading a base station converted from RINEX, we no longer auto-fill the datum converted from the 
position provided in the RINEX header, as this is unknown.  Instead, users are required to enter this or use 
the “Select from favourites” option in order to help ensure the accuracy of this information. 

• Users can now specify the epoch of base station coordinates for the purposes of tracking this through to 
the Export Wizard.  Currently, if entering a base station epoch for multi-base projects, all base station are 
required to have the same epoch.  

• Users can define different datums for each base station in a multi-base project, provided they share a 
common epoch.  The base station coordinates will be automatically converted to the processing datum 
prior to processing. 

•  “Select from Favourites”, “Compute from PPP”, “Use average position”, “Enter grid values”, and “Enter 
MSL height” buttons are now accessible under a “Coord. options” pull down on the master coordinate 
dialogue  

• The “total”, “fixed” and “restored” numbers of satellites reported in the processing dialogues and written to 
the message log files (in relation to the number used in ambiguity fixing) has been fixed to accurately 
display this information 

• New “Combine Two Solutions” dialogue which allows users to combine processed solutions for the 
purposes of comparison directly within GrafNav.  No knowledge of GrafNav’s file extensions is required 
when using the dialogue. 

• When accessing processed information from the map window (by clicking on processed epochs), the 
appropriate UTM zone will be automatically detected.  Previously, the map window would always default to 
UTM zone 15. 

• Added an error dialogue should a user attempts to load a GNSS data file which spans more than two 
weeks, which will result in a crash when attempting to allocate memory. 

• The Project Overview now reports the time range of GPB files in HH:MM:SS.ss format rather than in 
seconds  

• The Project Overview now includes the number of epochs for GPB files 

• Significant simplification of options accessible within Settings | Preferences, the Feature Editor, the Load 
Camera/Event marks utility, the right click menu options from the map window, the Window menu, the 
Download Service Utility, and the File menu. 

• Support has been removed for the processing history 

• Discontinued “Remove Processing Files” utility 

• Discontinued GPB to RINEX converter 

• Discontinued the “Copy User Files” utility 

• Removed the “CORS(CORS96)” and “IGS(ITRF05)” groups within the favourites manager to simplify 
available choices when downloading CORS or IGS base station data and using the “Select from 
favourites” option to load precise coordinates  
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Download Utility 

• Improved search techniques when using the “GPB Search Mode” which is necessary when the trajectory 
crosses the anti-meridian 

• When downloading hourly files, the utility will no longer run GPB pre-processing following conversion of 
each hourly file.  Rather, it will only perform pre-processing on the final combined file which results in a 
significant improvement in the time it takes to retrieve hourly data. 

 
Processing profiles 

• Advanced ARTK settings have been enabled within all manufacturer processing profiles which help 
minimize the chances of accepting an incorrect ambiguity fix while not significantly decreasing the 
chances of achieving a fix. 

• A GNSS Pedestrian profile has been added to the setup, which enables automated loading of this 
processing profile for pedestrian data sets 
 

Plots 

• Fixed an issue in the “Combined Separation” plots which would falsely report large values if an epoch had 
been rejected from forward or reverse processing 

• The combined weighting plot has been fixed such that it can be displayed after re-opening/loading of a 
project.  Previously, this plot could only be displayed after processing as the values were only saved in 
memory. 

• Fixed an issue computing 2D and 3D statistics directly from the plots  

• Fixed an issue in the File Data Coverage plot that would sometimes result in the GNSS file (base or 
remote) being plotted in the incorrect week 

• The number of Galileo and QZSS satellites have been added to the number of Satellites (Line) plot 

• Simplification of the available multi-base plots 
 
Pre-processing 

• Added a check for multiple precise files that cover the same day 

• Users will no longer be warned regarding the presence of L2C when processing PPP, as this is only a 
potential issue for ambiguity determination performance in differential processing 

• Fixed a base station resampling issue that occurred when both the “Data Rate” (indicating a data logging 
interval mismatch between the base and remote) and the “Too Many Small Gaps” error would occur in the 
same project 

• Pre-processing now limits itself to the start/end GNSS time range, which avoids reporting errors that occur 
outside of the processing range. 

• Users will be warned if any broadcast GLONASS ephemerides are missing in the project, as this is 
required for usage of the satellite regardless of whether a precise ephemeris is available 

• Fix to check base stations and remote files for dual frequency data prior to enabling /disabling ionospheric 
& tropospheric processing options  

 
Decoders 

• Added support for u-blox M8 receivers 

• Added support for the THISANTENNATYPE log in the NovAtel/SPAN decoder.  This enables users to log 
the antenna profile which will automatically flow through to GrafNav. 

• Added a progress bar for GPB pre-processing, which occurs automatically after conversion 

• Fixed an issue reading the last line of navigation parameters from some BeiDou RINEX navigation files 



GrafNav/GrafNet Version History 

21 February 2024 12 

• Fixed and issue in RINEX to GPB conversion issue which prevented decoding if the input file had a period 
within the filename 

 
Export Wizard 

• Combined Separation values can now be output for features/camera marks.  Previously this could only be 
exported for epochs. 

• Support has been introduced for exporting UTC time stamps correctly if your survey is conducted over a 
UTC leap second boundary 

• Users will no longer be prompted to enter an average ground height when exporting omega, phi, kappa 
values. 

• Removed “Combined RMS” export variables as they were only relevant to GrafNav Batch, which was 
discontinued as of version 8.30. 

• Removed interpolation and downsampling options for GNSS-only trajectories 

• Removed support for local grid definitions.  Users can still define local Cartesian systems rotated to local 
level, which is a far more common use-case. 

 
Moving Baseline Processing 

• The computed local level vector will no longer always be between the phase centers of the GNSS 
antenna.  Rather, it will reflect any L1 to ARP offset applied in the antenna model at the base and/or 
remote. 

 
GrafNet 

• All improvements to the GNSS processor, including GLONASS ambiguity fixing, updating ARTK to 
OEM060700RN, new constellation support (Galileo and QZSS), and handling of the time correlation of 
GNSS measurements, are also applicable to GrafNet. 

• The tropospheric error state, previously only available within GrafNav/IE, is now directly accessible within 
GrafNet’s processing options and will automatically be engaged when processing long baselines (> 150 
km).  This is effective at reducing residual tropospheric error in long baseline processing. 

• Improved logic when computing/accepting the final result from a processed vector in “float” mode, to help 
guard against poor data at the end of the session from contaminating the final result 

• Fixed an issue where ignored baselines were being un-ignored after removing observations from a project 
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